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You can punch holes (dots) to create patterns by installing a paper piercing tool into your cutting machine. Use only paper as the 
material.
This item is compatible with the Brother ScanNCut DX machine.

 WARNING
CHOKING HAZARD.

* This is not a toy and is not intended to be used by children. In order to prevent choking hazards, do not allow infants/children to put 
the protective caps in their mouths.

• Before installing the paper piercing tool into the paper piercing tool holder or before installing the paper piercing tool holder into the 
machine, remove the protective cap. After removing the holder from the machine or after removing the tool from the holder, be sure to 
attach the protective cap. Do not leave the holder or tool with the needle exposed. Otherwise, injuries may result.

 CAUTION
• Be sure to handle the paper piercing tool carefully so that no injuries occur.

In order to use the Paper Piercing function, it is necessary to update the software of the cutting machine to the latest version. For 
detailed instructions on updating the machine, refer to the Operation Manual supplied with it.
● Do not insert any object other than the paper piercing tools into the paper piercing tool holder.
● Be sure to turn on the machine before installing the paper piercing tool holder. If the holder is installed while the machine is off, 

the needle may break.
● Only pierce (punch holes in) paper with a thickness of 0.3 mm or less. Otherwise, the needle may break or be damaged.
● The cutting machine may not be able to pierce (punch holes in) some materials.
● The machine operation (hole size, shape, sounds, etc.) may differ under certain conditions.
● The paper piercing mat is compatible with paper piercing (hole punching), cutting and drawing.
● The paper piercing mat is incompatible with half-cutting and foiling.
● When drawing with the paper piercing mat, the material being drawn on may be damaged, depending on the shape of the pen 

tip.
● If the adhesive strength of the paper piercing mat has decreased, lightly wipe the sheet with a wet wipe (alcohol-free 

recommended), for example, to remove any dust or dirt. After wiping the mat, be sure to allow it to dry. If the mat becomes wet, 
its surface will become brittle.

● If material can no longer be attached to the paper piercing mat, replace the mat with a new one.
● Do not store in a location exposed to direct sunlight, high temperatures or high humidity.
● Use in an environment between 10 °C and 35 °C (50 °F and 95 °F).
● For detailed instructions on using the cutting machine, refer to the Operation Manual supplied with it.
● The contents of this document are subject to change without notice.
● The screens shown in this manual may differ from the actual ones.
● The screen used in the explanation are displayed in mm.
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After purchasing this kit, check the contents.

*1 These accessories are consumables. After you have used them up, purchase a paper piercing mat (CADXPPMAT1) or paper piercing tools 
(CADXPPTL1). To purchase options, contact the retailer where this kit was purchased.

a Touch “Premium Functions” in the settings screen.

b Select “ON” beside “Kit Activation (Paper Piercing)”.

Accessories

A B C

D E F

Part Name

A Paper piercing mat 12" × 12" (305 mm × 305 mm) *1

B Paper piercing tool holder

C Paper piercing tools (diameter 0.4 mm and 0.8 mm) *1

D Activation card for access to 30 paper piercing patterns

E Sample card 5" × 7" (127 mm × 178 mm)

F Envelope for sample card 5.2" × 7.2" (133 mm × 184 mm)

Activating the Paper Piercing Function on the Machine
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CanvasWorkspace has a large variety of paper piercing patterns that can be used immediately. In addition, you can create original 
patterns or edit existing ones.

● CanvasWorkspace (Windows/Mac) (ver. 2.2.0 or later) must be installed on your computer. The latest version of the application 
can be downloaded from the Brother Solutions Center (http://s.brother/caraa/).

● In order to use CanvasWorkspace, a CanvasWorkspace login ID is required. If you do not have a free account, click [Create New 
Account] in the screen that appears after installation, and then follow the on-screen instructions to create an account.

● If CanvasWorkspace is already installed on your computer and you want to update it to the latest version, select [Check for 
CanvasWorkspace Update…] from CanvasWorkspace’s [Help] menu, and then update it according to the on-screen instructions.

● The Paper Piercing kit is not compatible with CanvasWorkspace (Web).

a Start up CanvasWorkspace.

b In CanvasWorkspace, select [Account Settings...] from the [Help] menu.

c Click [Premium Function Activation].

d Type in the activation code on the included activation card, and then click [Activate].

• A connection to the Internet is required for activation.
• The uppercase letters “O” and “I” are not used in the activation code.
• The activation code is valid for only one CanvasWorkspace login ID. The same activation code cannot be used again. 

e When the activation confirmation message appears, check the information, and then click [Activate] if it is correct.

 Click [OK] to complete the activation.

Activating Paper Piercing Patterns in CanvasWorkspace

http://s.brother/caraa/
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Selecting an Activated Paper Piercing Pattern

a In the object panel, select  (Piercing).
 A list of paper piercing patterns appears.

b Select the desired pattern, and then drag it into the editing area.
• The selected pattern can also be added to the editing area by clicking the pattern in the list. 
• Activated paper piercing patterns cannot be enlarged or reduced.

c Use the desired method from the [File] menu to transfer the pattern to the cutting machine. For details on the transfer 
methods, refer to the Brother Solutions Center (http://s.brother/cfrab/).

a Transferring using a USB flash drive
Save the FCM file to a USB flash drive, and then transfer the file to the cutting machine.

b Transferring via a wireless network connection
Specify the wireless network settings on the cutting machine, and then transfer the FCM file.

c Transferring using a USB cable (compatible only with Windows)
Connect the USB cable to the cutting machine and computer, and then transfer the FCM file.

Preparing Paper Piercing Data in CanvasWorkspace

a

b

1
2
3

http://s.brother/cfrab/
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Creating an Original Pattern

For this example, the offset line created inside the selected cutting data pattern will be converted to dot data for paper piercing (hole 
punching), and then data combining the cutting data and the dot data will be created.

a Select the pattern to be pierced.

b Create an offset line inside (inward offset) the selected pattern.
• For details on editing in CanvasWorkspace, select [Online Video Tutorials...] from the [Help] menu.
• If the pattern will not be cut out, it is not necessary to add an offset line. Continue to step c to convert the cutting data to dot data for paper 

piercing (hole punching).

c Select the inner line created in step b, and then select [Pierce] below [Operation] in the control panel.

 The selected cutting data is converted to dot data.

d If necessary, change the color and spacing of the dots.

e Save the pattern, or send it to the cutting machine.
• For details, see “Selecting an Activated Paper Piercing Pattern” on page 4.

a Dot data
b Cutting data

a Dot color
b Dot spacing

1

2

a

c

1

2
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For detailed instructions on using the cutting machine, refer to the Operation Manual supplied with it.

■ Precautions
● Only pierce paper with a thickness of 0.3 mm or less. Otherwise, the needle may break or be damaged.

a Peel off the protective sheet from the paper piercing mat, and then attach the material to the mat.
• Attach the material so it does not extend from the adhesive side of the paper piercing mat.
• The paper piercing mat is compatible with paper piercing (hole punching) and cutting.

b Pull out the rear tray.
Before using the machine, be sure to pull out the rear tray.

c Raise the scanner lever (on the left side of the machine) to “2”.
• Since the paper piercing mat is thick, the lever must be set to “2” in order for the mat to be fed correctly.

d Select the location of the pattern to be retrieved, and then select the desired pattern.

Retrieving a Pattern From CanvasWorkspace to the Cutting Machine and Paper 
Piercing the Material
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e Press  to load the mat into the machine, and then touch  to scan the background. Position the pattern so it does not 
extend from the material.
• Scanning the background allows you to check the position of the pattern within the material. If the pattern extends out of the material, touch 

the “Edit” key, and then adjust the position of the pattern. The pattern can also be moved by dragging it in the screen.
• The size of a paper piercing pattern retrieved from CanvasWorkspace cannot be changed.

f Continue with step n (page 11) in “Selecting a Built-In Pattern and Perform Paper Piercing” to complete the procedure. 

For detailed instructions on using the cutting machine, refer to the Operation Manual supplied with it.

By converting a built-in pattern to dot data, you can enjoy paper piercing your favorite pattern.

In this example, we will use 2 functions both piercing and cutting.
First, the cutting function will be performed and then the piercing function will be performed using the dot data.

Note

• When cutting the cut data, there are uncut pieces as a joint part for paper piercing. Those parts are necessary to prevent the material 
from moving or peeling off during paper piercing. The amount of joint parts depends on the material and the pattern. This will only 
apply when the paper piercing mat is insert.

• The length of the joint parts can be adjust on the setting screen, for details refer to “Changing the Perforation Length” on page 12.

Selecting a Built-In Pattern and Perform Paper Piercing

a Cutting data
b Dot data

1

2
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■ Precautions
● Only pierce paper with a thickness of 0.3 mm or less. Otherwise, the needle may break or be damaged.

a Peel off the protective sheet from the paper piercing mat, and then attach the material to the mat.
• Attach the material so it does not extend from the adhesive side of the paper piercing mat.
• The paper piercing mat is compatible with paper piercing (hole punching) and cutting.

b Pull out the rear tray.
Before using the machine, be sure to pull out the rear tray.

c Raise the scanner lever (on the left side of the machine) to “2”.
• Since the paper piercing mat is thick, the lever must be set to “2” in order for the mat to be fed correctly.

d From the built-in patterns, select the pattern to be used for paper piercing.
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e Press  to load the mat into the machine, and then touch  to scan the background. Position the pattern so it does not 
extend from the material.
• Scanning the background allows you to check the position of the pattern within the material. If the pattern extends out of the material, touch 

the “Edit” key, and then adjust the position or size of the pattern. The pattern can also be moved by dragging it in the screen.

Memo

• Since the paper piercing mat is black, it may be difficult to see the pattern in the displayed background scan, depending on where the 
material has been attached.

In this case, touch , and then select  beside “Background” to make the background image lighter.

a Pattern

b Material scanned for the background

f Touch the “Edit” key, and then touch the “Object Edit” key to display the object editing screen.

g Touch  in the object editing screen to add an offset line to the pattern.

 If the pattern will not be cut out, it is not necessary to add an offset line. Continue to step i to convert the cutting data to dot data for paper 
piercing (hole punching).

1

2
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h Specify a setting for “Offset Distance” to create an offset line inside or outside the pattern and then touch “OK”.
For this example, specify a setting of “-5.00 mm (-0.20”)” to create an offset line 5 mm (0.20”) inside the pattern outline.
• The original pattern line appears in green and the newly added offset line appears in black.
• After the offset distance has been specified, it cannot be edited.

• When you touch  again after creating the offset line, another offset line will be created again.

a Created Offset line (The line which will convert to dot data)

i Select the pattern to be converted to dot data for paper piercing (hole punching), touch , and then select “ON” beside 
“Dot Line”.
• The spacing between the holes to be punched can be specified with “Dot Spacing”.

 The selected cutting data is converted to dot data.

j Install the auto blade holder (black) into the carriage.
• If the pattern will not be cut out, continue to step n to perform paper piercing.

k Select “Cut” in the preview screen.

 A preview of the cutting lines appears.

1
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l Touch the “Test” key to perform test cutting.
• Position the test cutting pattern so that it does not overlap the pattern for your project.
• The movement of the carriage differs from when using a cutting mat.

m Check the results of test cutting, and then, if it is acceptable, touch the “Start” key. When cutting is finished, remove the auto 
blade holder (black).
• There are uncut pieces as a joint part to prevent the material from moving or peeling off during paper piecing.
• If the material could not be cut cleanly, other than the joint part, increase the cutting pressure.
• If the test cut result is not appropriate, refer to “Changing the Perforation Length” on page 12 and change the “Perforation Length” setting.

n Remove the cap from the paper piercing tool holder. Select the paper piercing tool according to the size of hole to be 
punched, and then remove the protective cap from the tip of the tool. Align  on the paper piercing tool with  on the paper 
piercing tool holder, and then insert the tool into the tool holder. After installing the holder cap, insert the holder into the 
carriage.
• Be careful not to point the needle tip toward your hand.
• Before inserting the holder into the carriage, check if the tool moves up and down in the holder. If the tool moves, remove the cap, and then 

attach it again.

o Select “Pierce” in the preview screen.
 A preview of the dot data appears.

p Touch the “Test” key to place the test paper piercing pattern.
The test pattern for paper piercing will be arranged at the same position as the test cutting pattern from step l on page 11.

Touch  to move the test pattern for paper piecing to a different position.
The test pattern for paper piercing can also be moved by dragging it in the screen.
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q Touch the “Start” key to perform test paper piercing. Check the results of test paper piercing, and then, if it is acceptable, 
touch the “Start” key. 
• If the material peels off while paper piercing, stop the operation and refer to “Changing the Perforation Length” on page 12 and increase the 

joint part length by changing the “Perforation Length” (joint part) setting.

r Feed out the mat. Carefully peel the material from the mat and the joint parts from the material.
• Do not forcefully peel off the joint parts, it may damage your project.
• Depending on the material and the shape of the pattern, it may curl up after paper piercing.

Changing the Perforation Length

To prevent the material from moving or peeling off while paper piercing, there are uncut pieces as a joint part after cutting.
The appropriate length of the joint part may differ depend on the material and the paper piercing pattern. Change the “Perforation 
Length” setting according to the paper piercing result.

Note

• This setting is only available when “Kit Activation (Paper Piercing)” is set to “ON”.

a Touch  after selecting “Cut” in the preview screen.
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b Touch  or  to fine adjustment the length of the uncut part. Touch “OK” after setting change has specified.

* The default setting is “Medium”.

Memo

• You can also change the setting on the test cut setting screen (a) or “Piercing Setting” screen (b).

a

b

Cleaning the Paper Piercing Tools

After paper piercing (punching holes) for a long period of time, material on the adhesive side of the paper piercing mat will attach to 
the needle tip of the paper piercing tool.
Since this may prevent holes to be punched correctly, periodically clean the needle tip.
● Paper piercing tools are consumables. If the tool cannot properly punch holes, even after its tip has been cleaned, the needle tip 

may have broken off. In that case, replace the tool. It is not possible to replace only the needle.

a Remove the protective cap from the paper piercing tool.

b Using a commercially available brush, clean dust attached to the needle tip.

c Attach the protective cap to the paper piercing tool.

Paper Piercing result Solution

Can’t easily take off the pattern from the material.
Touch  and change the setting to “Short”.

The pattern moves or peel off while paper piercing.
Touch  and change the setting to “Long”.

Maintenance
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For this example, a project will be created using a paper piercing pattern (activated in CanvasWorkspace) that is split into parts 
together with paper piercing tools of different diameters.

The following four patterns split into parts are added to CanvasWorkspace after the Paper Piercing function is activated.

Selecting a Pattern and Transfer it to the Cutting Machine

a In the object panel, select  (Piercing).
 A list of paper piercing patterns appears.

b Select the desired pattern, and then drag it into the editing area.
• The selected pattern can also be added to the editing area by clicking the pattern in the list.
• Activated paper piercing patterns cannot be enlarged or reduced.

c Select the pattern, and then click [Ungroup] on the [Layer] menu.
• In order to perform paper piercing with each pattern part, the pattern must be ungrouped before being transferred to the cutting machine.
 Patterns split into parts are ungrouped.

d Use the desired method from the [File] menu to transfer the pattern to the cutting machine.
• For details, see “Selecting an Activated Paper Piercing Pattern” on page 4.

[Example] Creating a Project with Two Tools of Different Diameters

a

b
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Using Two Sizes of Paper Piercing Needles

Use a different needle diameter on each part of the pattern transferred from CanvasWorkspace, and perform paper piercing on each 
part separately.

a Retrieve the transferred pattern from the cutting machine.

b Load the mat (with the material attached) into the machine, and then touch  to scan the background. Position the 
pattern so it does not extend from the material.
• Scanning the background allows you to check the position of the pattern within the material. If the pattern extends out of the material, touch 

the “Edit” key, and then adjust the position of the pattern. The pattern can also be moved by dragging it in the screen.
• The size of a paper piercing pattern retrieved from CanvasWorkspace cannot be changed.

c After arranging the pattern, touch the “Save” key to save the pattern to the machine.

d Leave only the first pattern to be used for paper piercing, and then perform paper piercing (refer to step e below).
• Select all parts not to be used for paper piercing, and then touch  to delete them.

e Continue with steps n through q (page 11 to page 12) in “Selecting a Built-In Pattern and Perform Paper Piercing” to 
complete the operation.
• In order to perform paper piercing with the second part of the pattern, do not feed out the mat.

f After finishing the first operation, return to the home screen, and then retrieve the pattern saved in step c.
• Do not change the position of the retrieved pattern.

g Delete the part of the pattern used for paper piercing in step d to leave only the second part of the pattern.

h Change the paper piercing tool with the other diameter, and then perform paper piercing with the second part of the pattern.
Refer to steps n through q (page 11 to page 12) in “Selecting a Built-In Pattern and Perform Paper Piercing”.

i Feed out the mat, and then carefully peel the material from the mat.
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If the machine stops operating correctly, check the following possible problems as well as the FAQ on the Brother Solutions Center 
(http://s.brother/cfoag/) before requesting service. If the problem persists, contact Brother Customer Service or Brother authorized 
service center. An asterisk (*) listed as a reference page indicates the Operation Manual for the cutting machine.

* For details, refer to the Operation Manual for the cutting machine.

TROUBLESHOOTING

Symptom Possible cause (or result) Solution Reference

The material cannot be cleanly 
cut. (Besides the joint parts)

The blade is worn. Replace the blade with a new 
one.

→*

The cutting pressure (“Cut 
Pressure”) is incorrect.

Increase the “Cut Pressure” in 
the settings screen.

→*

Material moves or peel off while 
paper piercing.

The order of the procedure is 
incorrect.

Make sure to cut the pattern first 
and then perform paper piercing.

→page 7

The length of joint part 
(“Perforation Length”) is not 
appropriate for the design.

Set the length of joint part 
(“Perforation Length”) to “Long” 
in the settings screen.

→page 12

http://s.brother/cfoag/
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The following table lists some of the messages that may appear while the machine is operating as well as their corresponding 
solutions.
Perform the necessary operation according to the instructions in the message or the solution described here. If the problem persists, 
contact Brother Customer Service or Brother authorized service center.

Cutting Machine Error Messages

CanvasWorkspace Error Messages

Error Messages

Error Message (Cutting Machine) Cause/Solution

This mat cannot be used.

This message appears when you try to perform an operation 
incompatible with the paper piercing mat.
The paper piercing mat is compatible with “Pierce”, “Cut” and 
“Draw”. Select one of these operations. (page 1)

To scan with paper piercing mat, shift the scanner lever to position 
"2". The scanner lever (on the left side of the machine) is set to “1”.

 Set it to “2”. (page 8, page 6)Scanner lever is set to position "1".
Shift the scanner lever to position "2".

Includes a pattern converted to dot line on the mat.
Cannot reconvert the pattern once you save the pattern.

After a dot data pattern for paper piercing (hole punching) has been 
saved, it cannot be edited the next time that it is retrieved.
Editing functions, such as enlarging/reducing or adding an offset line, 
cannot be used with the cutting data of a pattern grouped together 
with dot data.

Error Messages (CanvasWorkspace) Cause/Solution

Please activate the piercing function. (E95001) If the Paper Piercing function is not activated, dot data cannot be 
opened. Activate the Paper Piercing function.

Operation not allowed. The selected objects include rhinestone data. 
(E95002)

Rhinestone data cannot be converted to dot data.
Select data that does not contain rhinestone data, and then convert it 
to dot data.

Unable to use the piercing data with the roll feeder function. Please 
select an artboard size other than "Rolled Material" in the Artboard 
Panel. (E95003)

This message appears when you try to save or transfer to a cutting 
machine dot data for paper piercing (hole punching) in the data 
format for the roll feeder.
Dot data cannot be used in the data format for the roll feeder. Select 
a size other than [Rolled Material] in the [Artboard Size], and use the 
paper piercing mat.
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